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Copyright and Trademark Notice
Copyright © 1999 by CTC Parker Automation. All rights reserved. No part of this pub
tion may be reproduced, transmitted, transcribed, stored in a retrieval system, in any
or by any means, mechanical, photocopying, recording or otherwise, without the prio
written consent of CTC Parker Automation.

While every precaution has been taken in the preparation of this manual, CTC Parker
mation and the author assume no responsibility for errors or omissions. Neither is an
liability assumed for damages resulting from the use of the information contained he
All product and company names are trademarks of their respective companies and lic

Product Warranty Information
CTC Parker Automation provides top quality products through rigid testing and the hig
quality control standards. However, should a problem occur with your hardware or wit
software protection key, CTC’s standard product warranty covers these items for 15
months from the date of shipment from CTC. Exceptions appear below:

• PowerStation backlight bulbs have a 90-day warranty. 

• Third-party products, such as bus cards, carry the manufacturer’s specified 
warranty.

• For all displays, image retention (burn-in) is not covered by warranty.

• Software revisions that occur within 60 days after purchase are available und
warranty upon request. Please review the Interact License Agreement for ad
tional software warranty information.

Should you have any questions about your application or need technical assistance,
call CTC’s Product Technical Support department at 513-248-1714, 8:00am to 5:00p
EST. You may call this same number after hours for emergency assistance. See Customer 
Support Services on page 7 of this manual for more information about CTC’s support p
ucts and services.
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C h a p t e r  1

Manual Overview and 
Support  Services

Welcome to MachineShop. MachineShop is an application that 

provides a simple, intuitive graphical interface for the manage-

ment of a machine profile or project. MachineShop pulls together 

the suite of machine control applications used to define a project, 

including Interact and MachineLogic, into a common toolbar 

interface that allows easy desktop access to the major functions of 

the software. MachineShop also includes multiple task wizards to 

make the management and creation of projects easier.
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Using this
Manual

This manual describes the MachineShop user interface and 
provides instructions on how to create and manage projects wh
use Interact applications and/or MachineLogic projects. You 
should read and understand the concepts presented in this ma
prior to operating MachineShop. This manual is divided into th
following chapters:

Chapter 1 - Manual Overview and Support Services: Presents 
an overview of the documentation that is provided with Machin
Shop. This chapter also provides an overview of the support 
services provided by CTC.

Chapter 2 - Introducing MachineShop: Describes the hardware
and software requirements for MachineShop. Also describes h
to navigate the MachineShop Toolbar, how to get help, and in
duces you to the user interface.

Chapter 3 - Managing Projects: Provides descriptive and 
instructional information on using MachineShop to manage yo
projects. This includes creating a project, opening an existing 
project, and viewing project information. 

Chapter 4 - Adding Connections: Describes how to set up the 
development system for file transfers. This includes adding 
MachineShop Net, IPM Compatible Serial, and disk transfer 
connections. MachineShop Net connections include a LAN, 
serial, Ethernet point to point and modem connection.

Chapter 5 - Backing Up Projects: Describes how to backup and
restore projects using the Backup and Restore Wizards. This 
includes backing up and restoring local and remote projects.

Chapter 6 - Transferring Projects: Describes how to transfer 
project files to and from the runtime system using the connectio
created in Chapter 3. 

Chapter 7 - Customizing MachineShop: Describes how to 
customize some of the basic MachineShop operations includi
adding and removing frequently used programs to the Machin
Shop Toolbar.

Appendix A - MachineShop Dial-Up Networking Connec-
tions: Describes how to create and configure MachineShop D
Up Networking connections in Windows 95/98 and Windows N

Appendix B - Cable Pinouts - Describes the cable pinouts for a
LAN cable, crossover cable, serial null modem cable with loop
back, and serial cable with hardware handshaking.
2 MachineShop Getting Started Guide
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MachineShop
Documentation

The MachineShop package includes all of the documentation 
need to install, configure, and run MachineShop. In addition, t
package includes all the necessary information to develop Inte
applications and MachineLogic projects. Extensive online help
exists for MachineShop, Interact, and MachineLogic as well. 
Please review the following list to verify that you have received 
necessary documentation.

Print Documentation MachineShop is shipped with the following print documentatio

License Agreement - The License Agreement explains the term
of the MachineShop component and serves as a certificate of
authenticity. This document also lists the product warranty info
mation provided by CTC. Make sure you read and understand
information in this agreement before you install and operate 
MachineShop. 

Customer Support Information - The Customer Support docu-
ment describes how to contact CTC with your comments, que
tions, and concerns regarding the MachineShop product.

What’s New in MachineShop - The What’s New in Machine-
Shop document describes what is new in MachineShop, Inter
and MachineLogic.

MachineShop Installation Booklet - The MachineShop Installa-
tion Booklet provides step-by-step instructions on how to insta
and configure all the necessary components of MachineShop. 
includes Interact and MachineLogic.

MachineShop Getting Started Guide - The MachineShop 
Getting Started Guide is designed to help you get up and runn
with MachineShop. Refer to the Using this Manual section on 
page 2 for a description of this manual.

Interact Getting Started Guide - The Interact Getting Started 
Guide is designed to help you get up and running with Interac
This manual describes Interact concepts, and includes examp
applications detailing the features of most Interact modules.

MachineLogic Getting Started Guide - The MachineLogic 
Getting Started Guide is designed to help you get up and runn
with MachineLogic. This manual describes the user interface a
provides instructions on how to create and online monitor 
MachineLogic projects.
MachineShop Getting Started Guide 3
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Electronic
Documentation

In addition to the MachineShop print documentation, the 
following electronic documentation is available:

MachineLogic Tutorial  - The MachineLogic Tutorial provides 
step-by-step instructions for using the MachineLogic Tutorial 
Template to create, download, and run a MachineLogic projec
The tutorial is a Portable Document Format (PDF) document a
is accessible from the MachineShop program group.

MachineLogic Reference - The MachineLogic Reference is a 
comprehensive guide to using MachineLogic. This guide provid
detailed instructions on how to create, edit, and compile Mach
Logic projects. It also describes some IEC 1131 basics. This 
manual is a Portable Document Format (PDF) document and 
accessible from the MachineShop program group.

MachineLogic Runtime Reference - The MachineLogic 
Runtime Reference provides information on the MachineLogic
Runtime kernel. It contains basic concepts and system specific
the MachineLogic Runtime to help you structure your Machine
Logic project. This manual is a Portable Document Format (PD
document and is accessible from the MachineShop program 
group.

Online Help Files - Extensive online help is accessible from 
MachineShop, Interact, and MachineLogic. The online help 
contains detailed information on the products and describes h
to perform all product operations. To access the online help av
able for a specific part of the program, press the F1 key on yo
keyboard.

I/O Driver Online Help - The I/O Driver online help is accessible
from the MachineShop Toolbar and the MachineShop program
group. The online help provides a technical overview of the I/O
driver and contains detailed instructions on how to configure t
I/O driver for MachineLogic.

Interact Tutorial  - The Interact Tutorial is an online help file tha
is designed to be run on the Interact development system. Th
help file includes step-by-step instructions for creating applica
tions using the Panel Toolkit Module (PTM), the Graphics Mon
toring Module (GMM), and the Alarm Management Module 
(AMM), which will help you become familiar with Interact. The
Interact Tutorial is accessible from the MachineShop program
group.
4 MachineShop Getting Started Guide
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Documentation

In addition to the documentation that is included in the Machin
Shop package, you should become familiar with the following 
documentation:

I/O Interface Card Documentation - This documentation is 
supplied by the manufacturer of your I/O interface card. Pleas
read this documentation in its entirety prior to downloading or 
running an Interact application or MachineLogic project.

PowerStation User Guide - If you are running MachineLogic or
Interact on a CTC PowerStation, you should have received th
manual. This manual explains how to configure, install, and 
operate the PowerStation. Please familiarize yourself with this
manual prior to operating the unit.

PowerStation CPU Manual - If you are running MachineLogic 
or Interact on a CTC PowerStation, you should have received 
manual. This manual is provided by the manufacturer of the C
board found in your PowerStation. Please familiarize yourself 
with this manual prior to operating the unit.

Workstation User Guide - If you are running MachineLogic or 
Interact on a non-CTC workstation, you should have received u
documentation for the unit. Please familiarize yourself with thi
manual(s) prior to operating the unit.

MachineShop Shell Runtime User Guide - This manual 
provides instructions on how to use the MachineShop Shell to
monitor and configure a PowerStation or any non-CTC workst
tion communicating with a development system running Machi
Shop. This includes creating and restoring backups and prepa
the workstation for transfers. Please read this manual prior to 
downloading an Interact application or MachineLogic project 
from the MachineShop toolbar.

Windows Documentation - This manual assumes you have a 
thorough knowledge of the Windows operating system when 
working with MachineShop. If this is not the case, then refer to 
documentation shipped with your operating system for details
Windows.
MachineShop Getting Started Guide 5
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Documentation
Standards

As you read this manual, you will notice that the following doc
mentation standards have been followed.

1. Important terms are shown in bold.

2. Text to be entered from the keyboard is shown in Courier  
font.

3. Buttons, menu titles, and keyboard keys are shown in Initi
Caps.

4. Indented paragraphs denote one of the following:

• Note - Describes alternative approaches or issues you
should be aware of while using a particular function.

• Important  - Contains information that needs particular
attention while reading the text. Follow this information
to save development time and/or minimize problems.

• Warning  - Contains information on safety issues. Follow
this information to prevent equipment damage or perso
injury.

ISO Symbols This symbol is the International Standards Organization (ISO)
symbol for Caution (ISO 3864 No. B.3.1). This symbol denote
information that could affect operation of the PowerStation if n
properly followed.

This symbol is the ISO symbol for Caution - risk of electrical 
shock (ISO 3864 No B.3.6). This symbol denotes information th
could cause personal injury from electrical shock or damage t
equipment if not properly followed.
6 MachineShop Getting Started Guide
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Support

Services

CTC welcomes your thoughts and suggestions on our produc
and services. You can contact CTC by telephone, email, or fa
You can also visit CTC on the World Wide Web to learn the late
about CTC hardware, software, and customer support service

• Telephone: 513-831-2340

• Fax: 513-831-5042

• E-mail: sales@ctcusa.com or support@ctcusa.com

• World Wide Web: http://www.ctcusa.com

CTC recognizes that every customer and every application ha
different support needs, so CTC offers a variety of support 
services designed to meet those needs. CTC offers three type
customer support services: Product Technical Support, Techn
Support Products, and the Product Support Program.

Product Technical
Support

The Product Technical Support department welcomes any ques-
tion that might arise as you develop or run your applications. W
offer complimentary support for any customer, whether you are
end user, original equipment manufacturer (OEM), or system in
grator.

If you have a question about MachineShop, Interact, or Machi
Logic, be sure to complete the following steps before contacti
the Product Technical Support department:

1. Check the Readme files installed with the software. These
files provide general information about the release.

2. Consult the appropriate documentation and other printed 
materials included with MachineShop, Interact, and Machin
Logic.

3. Check the online help. MachineShop, Interact, and Machi
Logic each have extensive online help facilities that cover 
aspects of the product.

If you cannot find a solution, contact the Product Technical 
Support department for help. Support lines are open during nor
business hours, Monday through Friday, 8:00am to 5:00pm E
You may call this same number after hours for emergency ass
tance.
MachineShop Getting Started Guide 7
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Technical Support
Products

Our Technical Support Products department provides service
two areas: training and consulting. CTC offers training on all o
products either at CTC in our state-of-the-art training center o
your site. You can learn how to write custom interfaces, devel
specialized applications, and implement your complete machi
control application. You can contact the Training Coordinator 
phone at 1-800-233-3329 or by email at training@ctcusa.com

CTC offers consulting services through our Professional 
Consulting Services (PCS) group. Our PCS group can build y
application from the ground up by writing custom, communica
tions drivers or designing special modules to perform function
unique to your application. Our team of specialists is flexible, 
they can create a project development schedule that meets yo
needs. You can contact the PCS Coordinator by phone at 1-8
233-3329 or by email at pcs@ctcusa.com.

Product Support
Program

The Product Support Program (PSP) is designed to keep you
to-date with the current version of MachineShop software. The
PSP consists of a renewable, one-year membership that prov
you with free upgrades, utilities, automatic notification of soft-
ware updates, and other valuable tools for MachineShop. Sing
user, site, and corporate licenses are available. The PSP is an 
cost-effective way to automatically receive the most recent 
MachineShop software and the associated utilities. You can 
contact the PSP Coordinator by phone at 1-800-233-3329 or b
email at psp@ctcusa.com.

Chapter
Summary

This chapter has provided a general overview of the documen
tion that is provided with MachineShop as well as the support
documentation that you may find useful as you develop Mach
Shop projects. This chapter has also provided an overview of 
CTC’s support products and services.

In the next chapter you will learn about the MachineShop use
interface as well as the system requirements for running Mach
Shop.
8 MachineShop Getting Started Guide
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Introducing MachineShop

MachineShop is a suite of software products designed for machine 

control. The Suite includes three machine control programs: 

Interact, MachineLogic, and the MachineShop Toolbar. The 

MachineShop Toolbar provides a simple user interface for 

managing a machine profile or project. The machine control 

programs that are managed by the MachineShop Toolbar are 

modular and may be used independently of one another.

This chapter describes the features of MachineShop and intro-

duces you to the MachineShop Toolbar. It also describes the 

system requirements for the MachineShop development and 

runtime systems. 
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MachineShop
Basics

MachineShop has a simple, easy-to-use interface for configur
and managing machine profiles or projects. Through the use o
wizards for multi-step procedures and explorer-type windows 
file management, MachineShop has simplified and automated
most common tasks associated with machine projects.

MachineShop provides the necessary functionality to develop
projects, including creating new projects, opening or backing u
existing projects, launching various Suite programs, and trans
ring projects and files to and from runtime workstations such a
PowerStations.

The purpose of MachineShop is to perform the following oper
tions:

• Provide a central location for managing the development a
runtime files for Interact and MachineLogic, whether used
together or separately

• Provide a simple user interface for transferring projects an
their components to target runtime workstations such as P
erStations

• Provide a simple user interface for backing up and restorin
projects to/from runtime workstations or a variety of storag
devices (diskette, Compact Flash, hard drive, network, etc

• Provide a variety of communication options for transferring
projects and performing backups, including serial, LAN, an
disk connections

The next section of this chapter will list the hardware and softw
requirements to run MachineShop. The remaining sections of 
chapter will discuss working with security keys and getting star
with MachineShop, including how to get help.
10 MachineShop Getting Started Guide
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Development
System

Requirements

The development system is the computer you plan to use to cr
and manage your MachineShop projects. This computer will n
be used to run the projects that you create. Instead, you will u
this computer to manage and transfer your projects to and fro
workstation which will be used to run your projects.

A workstation that runs MachineShop projects is referred to a
runtime system throughout this manual. A standard industrial P
may be used as a runtime system. This manual assumes you
using a CTC PowerStation as your runtime system.

Hardware
Requirements

Your development system must meet or exceed the following 
system requirements in order for MachineShop to perform as 
intended:

• Processor: Pentium 133MHz

• Memory: 24MB RAM (Windows 95/98 systems)

• Memory: 32MB RAM (Windows NT systems)

• Fixed Storage: 50MB of free hard disk space

• Removable Storage: CD-ROM drive

• Input Devices: keyboard and Microsoft compatible mouse

• Video: 800 x 600 resolution, 256 colors

• 10 MB Ethernet network interface or serial port

Software
Requirements

Your MachineShop development PC requires the following so
ware in order to develop MachineShop projects:

• Operating System: Windows 95 4.00.950B (OSR2), 
Windows 98 or Windows NT 4.0 SP3

Note DCOM 95 must be installed if using Windows 95/98. A 
self-extracting executable install is provided on the 
MachineShop install CD in the DCOM 95 directory. This
directory is automatically installed once you install 
MachineShop.

• Interact: Version 5.0 or later

Note Interact Version 6.0 is required if you are using Interact 
with MachineLogic.

• MachineLogic: Version 2.0 or later
MachineShop Getting Started Guide 11
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Installing the
Software

Refer to the MachineShop Installation Booklet for step-by-step 
instructions on how to install MachineShop.

Runtime System
Requirements

The runtime system is the PowerStation or industrial PC you p
to use to run your MachineShop projects. This computer will on
be used to run the projects you create. You will develop your 
projects on a development system and download them to this
computer.

The workstation used as a runtime system requires the Machi
Shop Shell. The “Shell” is an easy-to-use interface that comm
cates with the MachineShop development machine. For more
information on the MachineShop Shell, see the MachineShop 
Shell Runtime User Guide.

Hardware
Requirements

Your runtime system must meet or exceed the following Machi
Shop system requirements in order for MachineShop projects
perform as intended:

• Processor: 80386-SX 25MHz or higher

• Memory: 4MB

• Fixed Storage: 8MB

• Video: 320 x 240 or 640 x 480 resolution, 16 colors

• Input Device: Microsoft compatible mouse or equivalent

• Third Party I/O Card

• MachineLogic Control Adapter, if using MachineLogic 

• 10MB Ethernet network interface card or serial port

Important The MachineLogic Control Adapter must be installed 
before you can use projects that include MachineLogic 
components.

Installing the
Hardware

In order to run MachineLogic projects on your runtime system
you must install the MachineLogic Control Adapter and the app
priate I/O card in the runtime system. Refer to the MachineLogic 
Control Adapter Installation document and the document that 
came with your I/O card for step-by-step instructions on how t
install both the control adapter card and I/O card.
12 MachineShop Getting Started Guide
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Software
Requirements

Your runtime PC requires the following software in order to ru
MachineShop projects:

• Operating Systems: MS-DOS 6.22 or later 

• Interact Runtime: Version 5.0 or later

Note Interact Version 6 is required if you are using Interact wi
MachineLogic

• MachineLogic Runtime: Version 1.11 or later

• MachineShop Shell: Version 1.0 or later

Installing the
Software

Refer to the MachineShop Installation Booklet for step-by-step 
instructions on how to install and setup the MachineShop softw
components.

Working with
Security Keys

The MachineLogic and Interact software that is installed using 
MachineShop CD is run with a security key. This section 
describes options for viewing and enabling key options. 

Note The MachineShop Toolbar is not key protected and may
used on any appropriate system to transfer projects, cre
runtime system backups, or restore runtime backups.

Understanding the
Security Keys

Included with the MachineShop CD is a security key. The secu
key has a label on it which indicates the key type, key number, 
the serial number as shown below:
MachineShop Getting Started Guide 13
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Every security key has a unique 15-digit serial number. This se
number is used to provide assurance that unauthorized users
cannot use your copy of the Interact and MachineLogic softwa
without violating the License Agreement. Since your key has a
unique serial number, we can provide this protection by enabl
only the software options you have purchased.

The key is designed to plug directly into the parallel (printer) po
of your computer. A printer cable can be plugged into the othe
end of the key. Your printer will work normally as the presence
the key does not affect its operation.

Using the Security
Key Utility

The Security Key Utility allows you to program your Security 
Key. You can enable additional software options or transfer 
enabled software options between keys. 

A sample of the Security Key Utility screen is shown below.

This screen displays a check mark next to the options that are
enabled within your key. A single check mark in the Runtime 
column means that option is enabled for runtime operation on
Check marks in the Configuration and Runtime columns indica
that the option is enabled for application development and 
runtime.
14 MachineShop Getting Started Guide



Chapter 2: Introducing MachineShop Working with Security Keys

 
ck 

t 
 

ive 
h 
tivate 
 are 
ur 

e 

 

pear 

t, 
n 
For most users, the options you purchased are enabled at the
factory prior to shipping you the product. You should have che
marks shown for each option you ordered. If you do not have 
check marks next to the options you purchased, then you mus
enter the 8-digit “enable codes” printed on the Module Enable
Code Certificate.

Enabling Software
Options

When you order additional software components, you will rece
a Module Enable Code Certificate listing enable codes for eac
software option purchased. These enable codes are used to ac
the respective software options on the security key. The codes
generated for the key number and serial number printed on yo
key and are valid ONLY for that key.

To enable software options, follow these steps:

1. Install the software on your system following the procedur
described in the MachineShop Installation Booklet.

2. Make sure your key is attached to the parallel port of your
computer.

3. Click Start on the Taskbar.

The Start menu opens.

4. Select MachineShop from the Programs folder.

The MachineShop folder opens.

5. Click the Security Key Utility icon.

The Key Setup Main Menu is displayed.

6. Select the Enable Option command.

7. Enter an enable code to activate a software option.

8. Repeat steps 4 and 5 for each enable code.

As enable codes are entered, you will see a check mark ap
on the display to the right of the software option that is 
enabled. If the enable code was for activating developmen
two check marks will appear, one in the Configuration colum
and one in the Runtime column.

9. Return to the Security Key Main Menu.
MachineShop Getting Started Guide 15
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10. Exit the Security Key Utility by selecting the Exit Menu  
option.

You are returned to the Windows desktop.

Transferring Enabled
Options between

Keys

Enabled software options may be transferred from one key to
another. You must have two keys in order to transfer enabled
options, and both keys must be attached to the computer at th
same time. You can plug each key into a separate parallel por
you can cascade the two keys together and plug them into a si
parallel port.

The Security Key Utility identifies one key as the source and t
other as the destination. Enabled software options can only be
transferred from the source key to the destination key. Enable
options that were originally activated with an enable code and
subsequently transferred can be re-enabled only by transferrin
them back from another key.

To transfer options between keys, follow these steps:

1. Attach two keys to your computer (each in a parallel port, 
cascaded).

2. Click Start on the Taskbar.

The Start menu opens.

3. Select MachineShop from the Programs folder.

The MachineShop folder opens.

4. Click the Security Key Utility icon.

The Key Setup Main Menu is displayed.

5. Select the Transfer Option command from the Main Menu.

The Key Setup Utility automatically detects the two keys a
displays the options enabled in each one.

6. Select the Select Keys command from the Transfer Options 
menu to identify which key is the source and which is the 
destination.

7. Click on the Select Keys command to alternate source and 
destination, if necessary.

8. Choose the Select Option command from the Transfer 
Options menu.
16 MachineShop Getting Started Guide
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9. Select the option you want to transfer from the list of enab
options in the source key.

If necessary, specify whether to transfer Configuration On
Runtime Only, or Development (both).

10. Select Yes to transfer the selected option.

11. Exit the Security Key Utility  by selecting the Exit Menu .

You are returned to the Windows desktop.

Getting Started
with

MachineShop

Before you begin creating and managing projects in Machine-
Shop, there are a few important notices you should review.

Users of Interact
Project Manager (IPM)

MachineShop was designed to replace Interact Project Manag
(IPM); however, MachineShop is capable of reading projects t
were created in IPM, Interact, or MachineLogic. 

Note In order for MachineShop to read these projects, they m
be located in the MachineShop Projects directory on yo
hard drive. See Chapter 3 for information about the Project
Directory structure.

In fact, MachineShop will prompt you whenever you attempt to
open a project and it detects Interact or MachineLogic applicat
files on your system that are not part of a MachineShop projec
MachineShop displays the following message:
MachineShop Getting Started Guide 17
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Once the MachineShop files exist, you can use MachineShop
view and download all your projects to the PowerStation Shell t
you ordinarily download using IPM.

Important Creating MachineShop files does not prevent you from 
continuing to use IPM to download Interact projects to th
PowerStation Shell; however, you cannot use IPM to 
download Interact projects to the MachineShop Shell.

MachineShop is also capable of reading project backups that w
created with IPM. When you restore a project backup that was
created with IPM, MachineShop maintains the directory structu
for Interact projects.

Online Help Online Help is available if you have any questions about how 
perform a particular operation or need information about the 
elements appearing on the screen. To access the online help 
simply select Help from the MachineShop Toolbar. 

There are several ways to find help in the MachineShop help f
You may view the help contents, perform an index search, or 
search for specific words or phrases using the Find tab in the h
window.

MachineShop also provides What’s This Help. What’s This He
shows information about different elements on the screen. To 
the What’s This Help for a dialog box, click the question mark 
the upper right-hand corner of the screen and then click the op

To use the What’s This Help for a menu command or toolbar 
button, click What’s This? on the Help menu, and then click th
element you want information about.

Starting MachineShop MachineShop is a Windows-base program designed to run in 
Microsoft Windows environment.

To start MachineShop, complete the following steps:

1. Click Start on the Taskbar.

The Start menu opens.

2. Select MachineShop from the Programs folder.

The MachineShop folder opens.
18 MachineShop Getting Started Guide
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3. Click MachineShop Toolbar.

Note If you have a shortcut defined, double-click on the 
MachineShop Toolbar icon on your Windows desktop.

The MachineShop Toolbar and Welcome dialog appear on yo
screen as shown below. 

The Welcome dialog is designed to guide you through the proc
of creating a project, opening an existing project, opening and
downloading an existing project to the runtime system, and 
restoring a MachineShop project to the runtime system. 

The Welcome dialog will display on your screen each time you
start MachineShop unless you select the Don’t display this 
startup screen again box. You may turn the Welcome dialog 
back on at anytime by selecting the Show welcome dialog on 
startup box in the Options dialog.

MachineShop
Toolbar

Welcome to
MachineShop

dialog
MachineShop Getting Started Guide 19
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MachineShop
User Interface

The MachineShop user interface consists primarily of a toolba
that appears at the top of the Windows desktop by default. You
drag and drop the toolbar to any location on the screen. 

To drag the Toolbar to another location, complete the 
following steps:

1. Position the mouse cursor over the MachineShop Toolbar

2. Click and drag the Toolbar to the desired screen location.

You may also set the visibility of the toolbar using the Options
command on the Tools menu. See Chapter 7 to learn how to set 
the visibility.

Menus MachineShop provides conventional Windows menus that are
used to gain access to the variety of functions available in 
MachineShop. The commands you will use most frequently ar
also displayed on the toolbar.

File Menu

The File menu allows you to create a new project, open an exis
project, and close an open project. It also allows you to delete
projects and define the location where MachineShop project in
mation will be stored. 

Edit Menu

Enabled with open projects, the Edit menu allows you to view
modify the description and the MachineLogic I/O interface for th
current project. 

View Menu

The View menu allows you to view information about the curre
project. Available information includes the project name, locatio
description, size, as well as information specific to projects tha
contain Interact and/or MachineLogic. It also allows you to vie
a list of runtime systems that are currently connected to the de
opment system using a MachineShop Net LAN connection. 
20 MachineShop Getting Started Guide
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MachineShop Net is a type of connection between developme
and runtime systems. The simplest MachineShop Net connec
is a single development system connected to a single runtime
system via a serial cable; however, multiple development and
runtime systems can be connected to one another via a Local A
Network (LAN).

Tools Menu

The Tools menu allows you to create or restore backups for 
current projects or projects located on a remote system. It als
allows you to customize and configure MachineShop. You ma
add or remove a suite component to MachineShop. When you
a suite component, MachineShop adds a button to the Machin
Shop Toolbar and a command to the Tools menu. Selecting ei
the command or the button launches the associated applicatio

See Chapter 7 for a complete discussion on adding and removin
suite components.

Transfer Menu

The Transfer menu is used to download a project (and project
components) to or upload a project from a remote system. It is a
used to select, add, edit, or remove the connections that will b
used for transferring projects between MachineShop and a rem
workstation.

Window Menu

The Window menu allows you to close Interact and Machine-
Logic.

Help Menu

The Help menu includes the commands for finding help on 
MachineShop. This includes opening the help window, using t
context-sensitive help, and connecting to the CTC Parker webs
The Help menu also includes commands for viewing help for ea
of the I/O drivers supported by MachineLogic. 
MachineShop Getting Started Guide 21
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Toolbars Toolbars provide quick access to the commands you use mos
often in MachineShop. The MachineShop Toolbar is comprised
three smaller toolbars called rebars. A rebar is the individual 
segments of a toolbar. Rebars can be repositioned within a too
by clicking and dragging them with the mouse. 

The three rebars on the MachineShop Toolbar are: the Projec
Management Rebar, the Suite Navigation Rebar, and the Tran
Rebar.

Project Mana gement Rebar

The Project Management Rebar is used to execute project-rel
commands that you would otherwise select from the Machine
Shop File, Tools, and Help menus. 

Suite Navi gation Rebar

The Suite Navigation Rebar is used to launch applications that 
would otherwise launch from the MachineShop Tools menu o
from the Windows Start menu. By default, Interact and Machin
Logic are always available from this rebar if they have been 
installed. 

When a MachineShop project has been opened, the selected
program will lauch with the proper application already loaded.
Once Interact and MachineLogic have been launched, you ca
quickly switch back and forth between them by selecting their
toolbar button.

Additional buttons can easily be added to the Suite Navigation
Rebar. See Chapter 7 for instructions on how to add and remove
buttons.

Project Management
Rebar

Suite Navigation Rebar Transfer 
Rebar
22 MachineShop Getting Started Guide
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Transfer Rebar

The Transfer Rebar is used to execute transfer-related comma
that you would otherwise select from the MachineShop Trans
menu. 

Chapter
Summary

In this chapter you have learned about the system requirement
the MachineShop development and runtime systems. You als
learned the how to use the Security Key Utility to program you
Security Key and you were introduced to the MachineShop 
Toolbar.

In the next chapter, you will learn how to use the MachineSho
Toolbar to create and manage your own projects.
MachineShop Getting Started Guide 23
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Managing Projects 

Once you become familiar with the user interface, you can begin 

creating and managing projects which use Interact applications 

and MachineLogic projects. This chapter will show you how to 

create a project, open and edit a project, and view project informa-

tion. It also describes the directory structure of the MachineShop 

projects. 
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Open an Existing Project 32

Save a Project 33

Delete a Project 34

View Project Information 35

Edit a Project 36
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Overview of
MachineShop

Projects

A MachineShop project is a collection of related files and appli
tions that you create on a development system and download
runtime system. The purpose of a project is to group all the ne
sary files for HMI, PC based logic control, and special user 
defined startup programs for a machine control application 
together under a single name. You can create multiple projects
the development system to maintain various configurations of
runtime system’s tasks, but only one project can reside on a 
runtime system at one time.

Creating a new project is very simple in MachineShop. Machin
Shop includes a New Project Wizard to guide you through the
process of creating a project. Each project contains a specific
of files for running Interact applications and managing machin
control programs.

Project Directory
Structure

Projects are kept in a subdirectory named “Projects” under the
MachineShop directory. Each project that is made has its own
subdirectory. Project directories for Interact projects are creat
and stored under the \PROJECTS\INTERACT directory. Proje
directories for MachineLogic projects are created and stored un
the \PROJECTS\MACHLOG directory. 

The project directory structure is illustrated below:

C:\MACHSHOP
\PROJECTS

\CONFIG
\INTERACT

\PROJ_1
\APPFILES
\STARTUP

\PROJ_2
\PROJ_3

\MACHLOG
\PROJ_1
\PROJ_3
\TUTORIAL

The CONFIG directory holds the MachineLogic Runtime confi
uration files. The APPFILES directory holds subdirectories for
each application you create for your Interact project and the 
STARTUP directory holds any extra AUTOEXEC.BAT files or
driver system files, network initialization files, etc.

Related files and 
applications that you 
create on the 
development 
system are stored 
automatically in the 
project 
subdirectories.
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Startup Files

A runtime workstation may require its own set of “startup files”
such as the autoexec.bat or config.sys files, for loading system
drivers or terminate-stay-resident programs (TSRs) into memo
prior to running Interact. System drivers usually have a “.sys” 
extension and are loaded by a command placed in the config.
file. TSRs are typically loaded by a command in the autoexec.
file.

You can create your own startup files and copy these along w
any needed programs, such as drivers or TSRs, into the proje
\STARTUP directory. These files will be sent to the runtime wo
station during a project download.

Setting the
Project Path

You may define the location where MachineShop projects will 
stored by selecting the Project Path command from the File me
This path is set to MACHSHOP\PROJECTS by default. 

Note You cannot change the project path while a project is op
in MachineShop. 

To change the project path, complete the following steps:

1. Select the Project Path command from the File menu.

The Project Path dialog box appears.

2. Browse to the location on your hard drive where you want
MachineShop to store project files.

3. Click OK .
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Create a New
Project

You are now ready to create a project. MachineShop provides
New Project Wizard to guide you through the process.

To create a new project, complete the following steps:

1. Select the New Project command from the File menu or click
the New Project button in the toolbar.

The New Project dialog box appears.

2. Enter the name of the project. 

3. Enter a project description.

4. Select the applications (Interact and/or MachineLogic) tha
you want to use.

5. Click OK  to accept these changes.

The New Project Wizard appears. If MachineLogic is part 
the project, then the following window appears. If Machine
Logic is not part of the project, skip to step 8. 

6. Select one of the following templates from the list of availab
templates, and then click Next.

• Template for UCS DeviceNet - includes global variable
and I/O configuration for a UCS DeviceNet I/O driver.

• Template for SST ProfiBus - includes global variables 
and I/O configuration for an SST Profibus I/O driver.
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• Template for Simulated I/O - includes global variables 
and I/O configuration for simulating a MachineLogic 
project on your development PC.

• Template for Dummy I/O - includes global variables an
I/O configuration for an application that does not comm
nicate with I/O devices. This allows you to debug your a
plication prior to putting the control online.

• Template for Tutorial - includes global variables and I/
configuration for the MachineLogic Tutorial.

The following window appears.

7. Select the I/O interface that you want to use in your Machi
Logic application.

Make sure the I/O interface matches the hardware installed
the runtime system. 

8. Click Next if Interact is part of your project. Otherwise, click
Finish and skip to step 11.
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If Interact is part of the project, the following window appear

9. Enter a name and select the display resolution for your Inte
application.

The name can be eight characters or less.

10. Click Next to select the modules you want to use in your 
Interact application. 

The following window appears.

11. Double-click the modules in the list that you want to use in
your Interact application.
30 MachineShop Getting Started Guide



Chapter 3: Managing Projects Create a New Project

ur 

s 
12. Click Next to select the drivers you want to use in your 
Interact application.

The following window appears.

13. Double-click the drivers in the list that you want to use in yo
Interact application.

14. Click Finish when you are finished selecting the drivers.

The New Project Information dialog box appears.

The New Project Information dialog box displays the option
you have chosen using the New Project Wizard.
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15. Click OK  to create the project using these options, or click
Cancel to return to the last page of the New Project Wizard

16. Once the project is created, select the appropriate comma
from the Tools menu or click the appropriate button on the
toolbar to launch MachineLogic or Interact.

The program will open with the proper application ready for 
development.

Open an
Existing Project

Before developing your Interact application and/or MachineLog
project, you must open your project using the MachineShop 
Toolbar. Once the project is open, you can then launch Interac
MachineLogic. 

Note Project files use the .WMS extension. Each time you sele
the Open Project command, MachineShop searches the
project directory for Interact or MachineLogic application
files that are not part of a MachineShop project. If files a
found, MachineShop displays a message asking if you 
would like to create a MachineShop project file.

To open a project, complete the following steps:

1. Select the Open Project command from the File menu, or 
click the Open Project button on the toolbar.

The Open Project dialog box appears.

2. Browse to the location on your hard drive that contains the
project file.

Project files use the .WMS extension.
32 MachineShop Getting Started Guide



Chapter 3: Managing Projects Save a Project

lick 

n. 
e 

 to 
3. Click Open to open the project.

4. Select the appropriate command from the Tools menu or c
the appropriate button on the toolbar to launch Interact or 
MachineLogic.

The program will open with the proper application ready for 
development.

Save a Project You may save the current project to a local or network locatio
By default, the location is the current path setting set using th
Project Path command.

To save a project, complete the following steps:

1. Select the Save Project As command from the File menu.

The Save Project As dialog box appears.

2. Browse to the location on your hard drive where you want
save the project.

Project files use the .WMS extension.

3. Enter the name of the project in the File name box.

4. Click Save to save the project.
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Delete a Project You may delete any existing MachineShop project from any lo
tion using the Delete Project command. The Delete Project 
command also deletes the Interact and MachineLogic files ass
ated with the project as well as your startup files.

To delete a project, complete the following steps:

1. Select the Delete Project command from the File menu.

The Delete Project dialog box appears.

2. Browse to the location on your hard drive that contains the
project you want to delete.

Project files use the .WMS extension.

3. Enter the name of the project in the File name box.

4. Click Delete to delete the project.

Note You cannot delete a project if it is open in MachineShop

The Confirm Project Deletion dialog box appears.

5. Click Yes to delete the project.
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View Project
Information

You may view information about the active project on your loc
system using the Project Information command. This includes
startup files, Interact drivers and modules used, MachineLogic
application information, and version numbers for Interact and 
MachineLogic development and runtime components.

To view local project information, complete the following 
steps:

1. Open the project if you haven’t already.

2. Select the Project Information  command from the View 
menu or click the Project Information button on the toolbar

The Project Information property sheet appears. 

3. Click on one of the following tabs to view the available info
mation for this project:

• Project - Displays the name of the project, the location
where this project is stored, the description, and the si
of the individual components of this project.

• Startup Files - Displays the names of the startup files (
any) located in the startup folder of this project.

• Interact - Displays the names of the modules, drivers, a
Interact applications used in this project.
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• MachineLogic - Displays the names of the I/O interface
and the MachineLogic programs used in this project.

• Versions - Displays the version numbers for Interact a
MachineLogic development and runtime components 
used by this project.

Note The Interact and MachineLogic tabs are available only 
when they are part of the project.

4. Click OK  or Cancel to close the Project Information property
sheet.

Edit a Project You may view or edit the project description and the I/O interfa
for the active project using the Edit menu.

Project Description Use the Project Description command on the Edit menu to view
modify the description for the current project.

To modify the project description, complete the following 
steps:

1. Open the project if you haven’t already.

2. Select the Project Description command from the Edit menu

The Project Description dialog box appears.

3. Enter or edit a description in the Project Description area.

4. Click OK  to accept the new or modified description, or 
Cancel to return to the previous description.
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I/O Interface Use the I/O Interface command on the Edit menu to view or 
modify the MachineLogic I/O interface for the current project. 
The I/O interface refers to the hardware and software that is ne
sary to communicate between a PC running MachineLogic an
device or machine that is being controlled by that PC.

To modify the I/O interface, complete the following steps:

1. Open the project if you haven’t already.

2. Select the I/O Interface command from the Edit menu.

The Edit I/O Interface dialog box appears.

3. Select the I/O interface from the list of available interfaces

4. Click OK  to accept the new I/O interface or Cancel to return 
to the previous interface.

Chapter
Summary

In this chapter you have learned how to create and manage y
own projects. You also learned about MachineShop projects a
the project directory structure. 

In the next chapter, you will learn how to add connections that w
be used for transferring projects between MachineShop and a
remote workstation.
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Adding Connect ions

Before you can transfer files to the runtime system, you must 

create a transfer connection in MachineShop. A connection refers 

to the method used to transfer files to or from a runtime system. 

The type of connections available are MachineShop Network, 

IPM Compatible Serial and disk transfers. The MachineShop 

Network connection allows you to communicate with a runtime 

system using a serial cable, Ethernet point to point or over a LAN. 

Multiple connections can be defined for different types of connec-

tions. Connections can even be defined with the same connection 

type, but for different target runtime systems. 

This chapter provides instructions on how to set up MachineShop 

Network Connections for a LAN, serial, Ethernet point to point, 

and modem connection. It also describes how to add an IPM 

Compatible Serial and disk transfer connection.

Chapter Contents
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MachineShop
Net Connections

The MachineShop Network connection allows the developme
system to communication with a runtime system using Ethern
point to point, over a LAN, through a serial cable, or via mode

All MachineShop Net communications require the Transmissio
Control Protocol/Internet Protocol (TCP/IP) communications 
protocol. CTC chose this protocol because it is the primary 
communications protocol being used today. As its name impli
this is the same protocol that is the basis for Internet commun
tions—email (SMTP), file transfer (FTP), and most notably, th
World Wide Web (HTTP).

Additionally, serial and modem connections require Dial-Up 
Networking, and an Ethernet point to point connection require
you to configure the Ethernet card’s TCP/IP properties.

This section describes how to add MachineShop Net connecti
for a LAN, Ethernet point to point, serial, and modem connecti

LAN Connection Using the MachineShop Net connection you can connect a de
opment system to a runtime system through a Local Area Netw
(LAN). LAN communications are the preferred method of 
communication because they offer the fastest rates and the gre
flexibility.

To add a LAN connection in MachineShop, complete the 
following steps:

1. Open MachineShop.

2. Select the Add Connection command from the Transfer 
Menu or click the Add Connection button on the toolbar.

The New Connection dialog box appears.

3. Enter a name for this connection.
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4. Select MachineShop Net (Serial/LAN) as the connection 
type.

5. Click OK  to accept these choices.

The New Connection Wizard appears.

6. Select LAN  as the network connection type.

7. Select Define runtime system now and then click Details to 
define the specific parameters for the target runtime syste

The Network Details dialog box appears.
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8. Select one of the following options:

• IP Address - Select this option to specify the IP address
a runtime system. Enter the IP address in the top box 
the Name group.

• MachineShop Net Name - Select this option to specify
runtime system by name. This is the name you entered
ing the MachineShop Shell/Settings/TCP/IP/Net Name
command.

MachineShop automatically displays the names that it
able to detect in the list box. Select a name from the lis

Note The runtime system must be configured and connected 
it to appear in the MachineShop Net Name list.

• Host Name - Select this option to specify the host nam
such as www.ctcusa.com, of the runtime system. This 
tion requires a network with a domain name server (DNS
Your network administrator must also configure a host
name to match the IP address of the runtime system p
to using this option.

9. Click OK  to accept these choices.

You are returned to the New Connection Wizard.

10. Click Next to continue.

The following window appears.
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11. Enter a user name and password only if an FTP user name
password was entered on the runtime system. 

The user name and password must match what was entere
the runtime system using the MachineShop Shell/Settings
FTP commands for you to gain access to the runtime syst

12. Select Yes to enable passive transfers. Otherwise, select No. 

Passive transfers allow MachineShop to connect to an FT
server when the MachineShop Toolbar is behind a firewall.
most cases, you will NOT need passive transfers.

13. Click Finish to create the connection.

You are now ready to transfer projects that you create in Mach
Shop to a runtime system. See Chapter 3 for details on creating 
projects and Chapter 6 for details on transferring files.

If you need to make changes to the connection simply select t
Edit command from the Transfer menu. 

Ethernet Point to
Point Connection

Using the MachineShop Net connection you can connect a de
opment system to a runtime system through an Ethernet patc
cable. In addition to adding the connection in MachineShop, y
must configure the TCP/IP properties for the Ethernet card. 

This section describes how to configure the TCP/IP properties 
add the connection in MachineShop.

Confi gure TCP/IP Properties in Windows 95/98

Use the Network option in the Windows Control Panel to 
configure the Ethernet card’s TCP/IP properties. 

Note You may be asked to insert Windows installation disk(s) 
CD-ROM after making the adjustment.

To configure the TCP/IP properties in Windows 95/98, 
complete the following steps:

1. Double-click the Network icon in the Windows Control 
Panel.
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The Network control property sheet appears.

2. Click the Configuration  tab if it is not already in view.

The Configuration tab appears.

3. Select the TCP/IP network component for your Ethernet ca
from the list of components and then click Properties.
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The TCP/IP property sheet appears.

4. Click the IP Address tab if it is not already in view.

The IP Address tab appears.

5. Select Specify an IP Address and then enter the IP address
and IP mask for the development system.

CTC recommends that you enter 10.0.0.1 as the IP address
255.255.255.0 as the IP mask.

Note If you are using both serial and Ethernet point to point 
connections on the same development machine, you m
have different IP addresses for each connection.

6. Click the Advanced tab.
MachineShop Getting Started Guide 45



MachineShop Net Connections Chapter 4: Adding Connections

e 
The Advanced tab appears.

7. Select Set this protocol to be the default at the bottom of the 
screen.

8. Click OK  to accept these choices.

The Network control property sheet appears.

9. Click OK  to exit the Network control property sheet.

You are now ready to add the connection in MachineShop. Se
Add Connection in MachineShop on page 49 for instructions. 

Confi gure TCP/IP Properties in Windows NT

Use the Network option in the Windows Control Panel to 
configure the Ethernet card’s TCP/IP properties.

To configure the TCP/IP properties in Windows NT, complete 
the following steps:

1. Double-click the Network icon in the Windows Control 
Panel.
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The Network control property sheet appears.

2. Click the Protocols tab.

The Protocol tab appears.
MachineShop Getting Started Guide 47



MachineShop Net Connections Chapter 4: Adding Connections

 and 

ust 
3. Select TCP/IP Protocol from the list of Network Protocols 
and then click Properties.

The Microsoft TCP/IP property sheet appears.

4. Click the IP Address tab if it is not already in view.

The IP Address tab appears.

5. Select the Ethernet adapter for your card from the list of 
adapters.

6. Select Specify an IP address and then enter the IP address 
and IP mask for the development system.

CTC recommends that you enter 10.0.0.1 as the IP address
255.255.255.0 as the IP mask.

Note If you are using both serial and Ethernet point to point 
connections on the same development machine, you m
have different IP addresses for each connection.

7. Click OK  to accept these choices.

The Network control property sheet appears.
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8. Click OK  to exit the Network property sheet.

You are now ready to add the connection in MachineShop. 

Add Connection in MachineShop

Once you have configured the TCP/IP properties for the Ether
card, you can add the connection in MachineShop.

To add an ethernet point to point connection in MachineShop, 
complete the following steps:

1. Open MachineShop.

2. Select the Add Connection command from the Transfer 
menu.

The New Connection dialog box appears.

3. Enter a name for this connection.

4. Select MachineShop Net (Serial/LAN) as the connection 
type.

5. Click OK  to accept these choices.
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The New Connection Wizard appears.

6. Select LAN  as the network connection type.

7. Select Define runtime system now and then click Details to 
define the specific parameters for the target runtime syste

The Network Details dialog box appears.

8. Select IP Address and then enter the IP address of the runtim
system in the top box of the Name group.

Typically the IP address for the runtime system is 10.0.0.2

9. Click OK  to accept your entries.

You are returned to the New Connection Wizard.
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10. Click Next to continue.

The following window appears.

11. Enter a user name and password only if an FTP user name
password was entered on the runtime system. 

The user name and password must match what was entere
the runtime system using the MachineShop Shell/Settings
FTP commands for you to gain access to the runtime syst

12. Click Finish to create the connection.

13. Connect the development system to the Ethernet connect
using a cross-over 10Base-T cable.

You are now ready to transfer projects that you create in Mach
Shop to a runtime system. See Chapter 3 for details on creating 
projects and Chapter 6 for details on transferring files.

If you need to make changes to the connection simply select t
Edit Command from the Transfer menu.
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Serial Connection Using the MachineShop Net connection you can connect the 
development system to a runtime system using a serial cable 
hardware handshaking. MachineShop uses a specific dial-up e
named “MachineShop Phonebook Entry” to communicate with
the runtime system. The MachineShop Phonebook Entry is 
created when you install MachineShop. For details on the 
MachineShop installation program, see the MachineShop Installa-
tion Booklet. 

To add a serial connection in MachineShop, complete the 
following steps:

1. Open MachineShop.

2. Select the Add Connection command from the Transfer 
menu or click the Add Connection button on the toolbar.

The New Connection dialog box appears.

3. Enter a name for this connection.

4. Select MachineShop Net (Serial/LAN) as the connection 
type.

5. Click OK  to accept these choices.
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The New Connection Wizard appears.

6. Select Direct Connection (Serial) as the network connection
type.

Note This option uses a specific dial-up entry named “Machin
Shop Phonebook Entry”. This entry should have been 
created by the MachineShop installation program. 

If the installation program could not create the Machine
Shop Phonebook Entry, the Direct Connection option w
not be available. See Appendix A for instructions on how to 
manually create the MachineShop Phonebook Entry.

7. Select Define runtime system now and then click Details to 
define the specific parameters for the target runtime syste
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The Network Details dialog box appears.

8. Select IP Address and then enter the IP address of the runtim
system in the top box of the Name group.

Typically the IP address for the runtime system is 10.0.0.2

9. Click OK  to accept these choices.

You are returned to the New Connection Wizard.

10. Click Next to continue.

The following window appears.

11. Enter a user name and password only if an FTP user name
password was entered on the runtime system. 
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The user name and password must match what was entere
the runtime system using the MachineShop Shell/Settings
FTP commands for you to gain access to the runtime syst

12. Click Finish to create the connection.

13. Connect the serial cable to the appropriate serial port of th
development system.

You are now ready to transfer projects that you create in Mach
Shop to a runtime system. See Chapter 3 for details on creating 
projects and Chapter 6 for details on transferring files.

If you need to make changes to the connection simply select t
Edit Command from the Transfer menu.

Modem Connection The MachineShop Net Connection also allows a remote comp
to connect to a runtime system through a modem. This connec
uses Windows Dial-Up Networking to dial into a LAN-based 
remote access server. 

You must configure Dial-Up Networking in order to dial into th
remote access server. Dial-Up Networking is available from th
My Computer icon on the Windows desktop. Once you have 
created and configured the dial-up connection, you can add th
connection in MachineShop. 

To add a modem connection in MachineShop, complete the 
following steps:

1. Open MachineShop.

2. Select the Add Connection command from the Transfer 
menu or click the Add Connection button on the toolbar.

The New Connection dialog box appears.

3. Enter a name for this connection.
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4. Select MachineShop Net (Serial/LAN) as the connection 
type.

5. Click OK  to accept these choices.

The New Connection Wizard appears.

6. Select Dial-Up Networking as the network connection type
and then select the dial-up entry from the list box.

The list box displays the available dial-up entries that you c
associated with this connection. These entries are created
using Windows Dial-Up Networking available from the My
Computer icon on the Windows desktop. See Appendix A for 
instructions on creating and configuring a MachineShop d
up connection .

7. Select Define runtime system now and then click Details to 
define the specific parameters for the target runtime syste
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The Network Details dialog box appears.

8. Select IP Address and then enter the IP address of the runtim
system in the top box of the Name group.

This is the IP address of the runtime system assigned by t
network. Check with your local network administrator to 
determine a valid IP Address to be used on your local netw

9. Click OK  to accept your entries.

You are returned to the New Connection Wizard.

10. Click Next to continue.

The following window appears.
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11. Enter a user name and password only if an FTP user name
password was entered on the runtime system. 

The user name and password must match what was entere
the runtime system using the MachineShop Shell/Settings
FTP commands for you to gain access to the runtime syst

12. Select Yes to enable passive transfers. Otherwise, select No.

Passive transfers allow MachineShop to connect to an FT
server when the MachineShop Toolbar is behind a firewall.
most cases, you will NOT need passive transfers.

13. Click Finish to create the connection.

You are now ready to transfer projects that you create in Mach
Shop to a runtime system. See Chapter 3 for details on creating 
projects and Chapter 6 for details on transferring files.

If you need to make changes to the connection simply select t
Edit Command from the Transfer menu.

IPM Compatible
Connection

The Interact IPM Compatible Serial connection is used to trans
projects to a CTC PowerStation that has the PowerStation Sh
installed on it. This connection supports the transfer of Interac
projects only, and is supplied for backward compatibility with 
existing systems. The Interact IPM Compatible connection use
serial port connection between the MachineShop developmen
system and the PowerStation.

Note This connection replaces IPM connectivity. IPM is a DO
based utility that is optimized for handling serial ports an
the transfer of files through them. This connection will 
provide the same capability as IPM. Due to the addition 
overhead in handling of serial ports in the Windows env
ronment, the length of time necessary to transfer files w
this connection may increase from the transfer times wh
using IPM.

To add an Interact IPM Compatible connection, complete the 
following steps:

1. Open MachineShop.

2. Select the Add Connection command from the Transfer 
menu or click the Add Connection button on the toolbar.
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The New Connection dialog appears.

3. Enter a name for this connection.

4. Select IPM Compatible (Serial) as the connection type.

5. Click OK  to accept these choices.

The New Connection Wizard appears.

6. Select the COM port and baud rate you will be using in thi
connection.

7. Click Finish to create the connection.

You are now ready to transfer Interact projects to a CTC Pow
Station that has the PowerStation Shell installed on it. See Chapter 
6 for details on transferring files.

If you need to make changes to the connection simply select t
Edit Command from the Transfer menu.
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Disk Transfer
Connection

Files may be transferred directly to a Compact FLASH or netwo
drives using the Disk Transfer connection. 

To add a disk transfer connection, complete the following 
steps:

1. Open MachineShop

2. Select the Add Connection command from the Transfer 
menu or click the Add Connection button on the toolbar.

The New Connection dialog box appears.

3. Enter a name for this connection.

4. Select Disk as the connection type.

5. Click OK  to accept these choices.

The New Connection Wizard appears.
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6. Select the letter of the drive you will be using in this conne
tion.

You may select any removable drive such as a floppy driv
Compact FLASH, or Zip drive.

7. Click Finish to create the connection.

You are now ready to transfer projects that you create in Mach
Shop to a runtime system. See Chapter 3 for details on creating 
projects and Chapter 6 for details on transferring files.

If you need to make changes to the connection, simply select 
Edit Connection command from the Transfer menu.

Chapter
Summary

In this chapter you have learned how to prepare the developm
system for file transfers. This includes setting up a LAN, seria
Ethernet point to point, and modem connection. You also learn
how to add an IPM Compatible Serial and disk transfer conne
tion.

In the next chapter, you will learn how to use MachineShop to
create and restore backups for current projects or projects loc
on a runtime system.
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Backing Up Projects 

MachineShop provides a wizard for backing up and restoring 

projects to and from runtime workstations or a variety of storage 

devices (diskette, Compact Flash, hard drive, network, etc.). This 

chapter describes how to create and restore a project backup for a 

current project or a project located on a runtime system. It contains 

both descriptive information and step-by-step instructions.

Chapter Contents
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Restoring a Backup 67

Chapter Summary 72



Creating a Backup Chapter 5: Backing Up Projects

the 
 
rage 
rk. 

e as 

m 
. 

 to 
Creating a
Backup

MachineShop provides a Backup Wizard to guide you through 
process of backing up a local project or a project on a runtime
system to a selected target. The target can be a variety of sto
devices including diskette, Compact Flash, hard drive, or netwo

Projects are compressed into a subdirectory with the same nam
the project. After the project is backed up, the file names are 
appended with a .zip suffix.

Local Project Backup You may backup the current project on the development syste
using the Project command from the Create Backup submenu
This command will launch the Backup Wizard.

To backup a local project, complete the following steps:

1. Open the project if you haven’t already.

2. Select the Create Backup command from the Tools menu.

The Create Backup submenu appears.

3. Select the Project command from the Create Backup 
submenu.

The Backup Wizard appears.

4. Enter the full path including the drive letter where you want
store this backup.
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5. Select the components that you want to include in the bac

• Runtime Program Files - includes the Interact and 
MachineLogic runtime program files.

• Application Files - includes the Interact and Machine-
Logic application files in the backup.

• MachineLogic Source Backup - includes the zip (.ZWT
file of the MachineLogic source files in the backup. 

Note The MachineLogic Source Backup option is only availab
if you have created the zip (.ZWT) file for the project usin
the “Save Project/Zip Project as” command in MachineL
ogic. 

6. Click Finish.

The Backup Project Information window appears.

7. Click OK  to backup the active project on the development
system.

The Backing Up dialog box appears.

8. Click Close when the backup operation is done.
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Remote Project
Backup

You may backup an active project on a runtime system using 
Remote System command from the Create Backup submenu. 
command will launch the Backup Wizard.

Note You must create the connection you plan to use to comm
nicate with the runtime system before you can create th
remote project backup. See Chapter 4 for information on 
adding connections.

Important You can only back up projects on the runtime system wh
the MachineShop Shell’s Main Menu is displayed on the
screen.

To backup a project on a runtime system, complete the 
following steps:

1. Select the connection you want to use from the Select 
Connection box on the MachineShop Toolbar.

2. Select the Create Backup command from the Tools menu.

The Create Backup submenu appears.

3. Select the Remote System command from the Create Backup
submenu.

The Backup Wizard appears.

4. Enter the full path including the drive letter where you want
store this backup.
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5. Select the components that you want to include in the back

• Runtime Program Files - includes the Interact and 
MachineLogic runtime program files.

• Application Files - includes the Interact and Machine-
Logic application files in the backup.

• MachineLogic Source Backup - includes the zip (.ZWT
file of the MachineLogic source files in the backup. 

6. Click Finish to backup up the project on the runtime system

The Transferring dialog appears. It displays the current file
being transferred, the direction, and the estimated time 
remaining in the transfer.

7. Click Close when the backup operation is done.

Restoring a
Backup

MachineShop provides a Restore Wizard to guide you through
process of restoring a project backup to either the developmen
runtime system. The backup may be located on a variety of stor
devices including diskette, Compact Flash, hard drive, or netw

Restore Backup to the
Local System

You may restore a project from a selected source to the deve
ment system using the Project command from the Restore Bac
submenu. This command will launch the Restore Wizard. The
Restore Wizard will automatically decompress the backup and
restore it to the location set in the Project Path dialog box.

To restore a project backup to the development system, 
complete the following steps:

1. Select the Restore Backup command from the Tools menu.

The Restore Backup submenu appears.

2. Select the Project command from the Restore Backup 
submenu.
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The Restore Wizard appears.

3. Enter the full path including the drive letter where the back
is stored.

4. Select the project you want to restore from the list of proje
backups.

5. Click Next.

The following window appears.

6. Select the components of the project that you want to inclu
in the restoration and then click Finish.
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The Restore Project Information window appears.

7. Click OK  to restore the project on the development system

The Restore dialog box appears.

Note If there is a current project with the same name as the 
project backup, the Restore Project dialog box appears. T
Restoration process will delete the current project before
restores the backup. To continue the restoration proces
click Restore. To rename the current project first, click 
Rename, or to exit the restoration process, click Cancel.

8. Click Close when the restore operation is done. 
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Restore Project to a
Remote System

You may restore a project backup from a selected source to a
runtime system using the Remote System command from the
Restore Backup submenu. This command will launch the Res
Wizard. The Restore Wizard will automatically decompress th
project backup and load it on the runtime workstation.

Note You must create the connection you plan to use to comm
nicate with the runtime system before you can restore a
project to it. See Chapter 4 for information on adding 
connections.

Important You can only restore backup projects to the runtime syst
when the MachineShop Shell’s Main Menu is displayed o
the screen.

To restore a project backup to a runtime system, complete the 
following steps:

1. Select the connection you plan to use from Select Connectio
box on the MachineShop Toolbar. 

2. Select the Restore Backup command from the Tools menu.

The Restore Backup submenu appears.

3. Select the Remote System command from the Restore 
Backup submenu.

The Restore Wizard appears.
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4. Enter the full path including the drive letter where the back
is stored.

5. Select the project you want to restore from the list of proje
backups.

6. Click Next.

The following window appears.

7. Select the components of the project that you want to inclu
in the restoration and then click Finish.
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The Restore Remote Information window appears.

8. Click OK  to restore the project on the runtime system.

The Transferring dialog box appears on the screen. It displ
the current file being transferred, the direction, and the es
mated time remaining in the transfer.

9. Click Close when the restore operation is done.

Chapter
Summary

In this chapter you have learned how to create and restore pro
backups. This included current projects and projects located on
runtime system. 

In the next chapter, you will learn how to use MachineShop to
download a project to and upload a project from a remote syst
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Transferr ing Projects 

Once an application has been developed and a connection created, 

you can transfer the files needed to create or update a runtime 

system. MachineShop provides a Transfer Wizard to step you 

through the process of selecting a connection and transferring the 

files to and from a runtime system. 

This chapter provides instructions on how to download and upload 

an active project from the development system to a runtime 

system. This includes using the Transfer Wizard and the Down-

load and Upload commands.
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Chapter Summary 81
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Downloading a
Project

Downloading refers to the process of transferring project files 
from a development system to a runtime system. There are tw
ways to download files in MachineShop: the Transfer Wizard a
the Download command. This section describes how to use th
two methods to download files to the runtime system.

Important You can only download project files to a runtime system
when the MachineShop Shell’s Main Menu is displayed o
the screen.

Transfer Wizard The Transfer Wizard steps you through the process of selecting
transfer connection and downloading the project files to a runti
system. 

To download a project to a runtime system using the Transfer 
Wizard, complete the following steps:

1. Open the project if you haven’t already.

2. Select the Transfer Wizard command from the Transfer 
menu.

The Transfer Wizard appears.

3. Select Download to Runtime to download the project to the
runtime system.

4. Click Next to continue.
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The following window appears.

5. Select the connection you want to use to transfer the files fr
the list of connections.

You may also create a connection from here. Click Define 
New Connection and follow the instructions provided by the
New Connection Wizard. See Chapter 4 for more information 
on how to add a new connection.

6. Click Next to continue.

The following window appears.
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7. Select Complete Project to download the entire project to the
runtime system. 

If you do not want to download the entire project, clear the
Complete Project check box; then select the files you want
download from the Components group box.

Note Application Files also include the MachineLogic source 
file (.ZWT file) if MachineLogic is part of the project. 
MachineShop expects this file to be in the project director
If this file is not in the project directory, a warning messag
will appear notifying you that the file does not exist whe
you click Finish.

8. Select All Files to download all of the files or Update Files 
Only to download only the files that have changed since th
last download.

9. Click Finish to download the project files to the runtime 
system.

The Transferring dialog appears. It displays the current file be
transferred, the direction, and the estimated time remaining in
transfer.

Download Command You can also use the Download command to download projec
files on the development system to a runtime system. 

Note You must create the connection you plan to use to comm
nicate with the runtime system before you can use the 
Download command. See Chapter 4 for information on 
adding connections.

To download a project to the runtime system using the Down-
load command, complete the following steps:

1. Open the project if you haven’t already.

2. Select the connection you want to use to transfer the files fr
the Select Connection box on the toolbar.

3. Select the Download command from the Transfer menu or 
click the Download button on the toolbar. 
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The Download dialog box appears.

4. Select Complete Project to download the entire project to the
runtime system. 

If you do not want to download the entire project, clear the
Complete Project check box; then select the files you want
download from the Components group box.

Note Application Files also include the MachineLogic source 
file (.ZWT file) if MachineLogic is part of the project. 
MachineShop expects this file to be in the project director
If this file is not in the project directory, a warning messag
will appear notifying you that the file does not exist whe
you click Finish.

5. Select All Files to download all of the files or Update Files 
Only to download only the files that have changed since th
last download.

6. Click Download to download the project files to the runtime
system.

The Transferring dialog appears. It displays the current file be
transferred, the direction, and the estimated time remaining in
transfer.
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Uploading a
Project

Uploading refers to the process of transferring a project from a
runtime system to a development system. Like Downloading, 
there are two ways to upload files in MachineShop: the Trans
Wizard and the Upload command. This section describes how
use the two methods to upload project files from the runtime 
system.

Important You can only upload project files from a runtime system
when the MachineShop Shell’s Main Menu is displayed o
the screen.

Transfer Wizard The Transfer Wizards steps you through the process of select
the transfer connection and uploading the project files from th
runtime system.

To upload a project from the runtime system using the 
Transfer Wizard, complete the following steps:

1. Select the Transfer Wizard  command from the Transfer 
menu.

The Transfer Wizard appears.

2. Select Upload from Runtime to upload a project from the 
runtime system.

3. Click Next to continue.
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The following window appears.

4. Select the connection you want to use to transfer the files fr
the list of connections.

You may also create a connection from here. Click Define 
New Connection and follow the instructions provided by the
New Connection Wizard. See Chapter 4 for more information 
on how to add a new connection.

5. Click Next to continue.

6. The following window appears.
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7. Select Complete Project to upload the entire project to the 
runtime system. 

If you do not want to upload the entire project, clear the 
Complete Project check box; then select the files you wan
upload from the Components group box.

8. Select All Files to upload all of the files or Update Files Only 
to upload only the files that have changed since the last 
upload.

9. Click Finish to upload the project files from the runtime 
system.

The Transferring dialog appears. It displays the current file be
transferred, the direction, and the estimated time remaining in
transfer.

Upload Command You may also use the Upload command to upload files from th
runtime system to the development system. 

Note You must create the connection you plan to use to comm
nicate with the runtime system before you can use the 
Upload command. See Chapter 4 for information on 
adding connections.

To upload a project from the runtime system using the Upload 
command, complete the following steps:

1. Select the connection you plan to use to transfer the files fr
Select Connection box on the toolbar.

2. Select the Upload command from the Transfer menu or click
the Upload button on the toolbar.
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The Upload dialog box appears.

3. Select Complete Project to upload the entire project to the 
runtime system. 

If you do not want to upload the entire project, clear the 
Complete Project check box; then select the files you wan
upload from the Components group box.

4. Select All Files to upload all of the files or Update Files Only 
to upload only the files that have changed since the last 
upload.

5. Click Upload to upload the project files from the runtime 
system.

The Transferring dialog appears. It displays the current file be
transferred, the direction, and the estimated time remaining in
transfer.

Chapter
Summary

In this chapter you have learned how to download and upload
project files to and from the runtime system. This included usi
the Transfer Wizard and the Download and Upload command
perform the transfer. 

In the next chapter, you will learn how to customize MachineSh
to meet your specific needs.
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C h a p t e r  7

Customizing MachineShop

You may customize some of the basic MachineShop operations to 

suit your needs. This chapter describes how to add frequently used 

programs to MachineShop, set the visibility of MachineShop on 

the desktop, and reposition the toolbars.

Chapter Contents
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Chapter Summary 87
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Set the Visibility You may determine how MachineShop will appear on your 
desktop. You may have the MachineShop Toolbar visible at a
times or you may have the toolbar automatically hide whenev
the mouse pointer is outside the region occupied by the toolba

You set the visibility options using the Options command from t
Tools menu.

To set the visibility of MachineShop, complete the following 
steps:

1. Select the Options command from the Tools menu.

The Options dialog box appears.

2. Select Always on Top to keep MachineShop on top of all 
applications.

Note This option is checked by default and only available whe
the MachineShop Toolbar is undocked. 

3. Select AutoHide to hide MachineShop until you move the 
mouse into the region occupied by the MachineShop Toolb

Note This option is cleared by default and is only available wh
the MachineShop Toolbar is docked.

4. Click OK  to accept these choices.
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Move the
MachineShop

Toolbars

MachineShop is docked to the top of the Windows desktop by
default. You may undock the toolbar by simply dragging it awa
from the edge. Once the toolbar is undocked, you can move it
anywhere on the screen.

To undock the MachineShop Toolbar, complete the following 
step:

1. Position the mouse cursor over the MachineShop Toolbar

2. Click and drag the toolbar away from the edge of the Windo
desktop.

The toolbar appears as shown below.

To dock the MachineShop Toolbar, complete the following 
steps:

1. Position the mouse cursor over the MachineShop title bar

2. Click and drag the toolbar to the top of the Windows deskt

The toolbar snaps into place along the length of the screen ed

Move the
MachineShop Rebars

The MachineShop Toolbar includes three smaller toolbars cal
rebars. These rebars can be repositioned on the toolbar by clic
and dragging the small handlebars.

To move the MachineShop rebars, complete the following 
steps:

1. Position the mouse cursor over the handlebar of the rebar 
want to move.

2. Click and drag the rebar to the desired position.

Handlebar
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Add and
Remove Suite

Component

You can add and remove frequently used programs to Machin
Shop. Once the program is added, you can then launch the 
program by clicking on the button on the MachineShop Toolba
or by selecting the command from the Tools menu.

This section describes how to add and remove programs from
MachineShop. 

Add a Program You can add a program to MachineShop using the Add Suite 
Component command. After you add a program, you will be a
to launch the program by clicking on a button on the MachineSh
Toolbar or by selecting a command from the Tools menu.

To add a program to MachineShop, complete the following 
steps:

1. Select the Add Suite Component command from the Tools 
menu.

The Add Suite Component dialog box appears.

2. Browse to the location on your hard drive that contains the 
you want to add.

This can be any type of file, for example, an executable 
(.EXE) file, an Excel (.XLS) file, the configuration file for 
your I/O driver, etc.

3. Click Open to accept this choice.
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Remove a Program You can remove a program from the MachineShop that you pr
ously added using the Add Suite Component command. Mach
Shop removes the associated button and menu command.

To remove a program from MachineShop, complete the 
following steps:

1. Select the Remove Suite Component command from the 
Tools menu.

The Remove Suite Component dialog box appears.

2. Select the icon for the program you want to remove.

3. Click Remove to accept this choice.

Chapter
Summary

In this chapter you have learned how to add and remove progr
from MachineShop, reposition the toolbars, and configure the
visibility options. 

The remainder of this manual includes appendices that provid
information on how to manually create the MachineShop Phon
book Entry and construct your own cable. 
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MachineShop Dial-Up Networking Connections

This appendix describes how to create and configure dial-up networking connections for Ma
Shop. Dial-Up Networking is available from the My Computer icon on the Windows desktop

Note If you need to modify the TCP/IP settings or the modem’s baud rate for a dial-up con
tion, see the Configure the Connection sections in this appendix. Windows 95/98 instruc
tions start on page 91 and Windows NT instructions start on page 97.

95/98 Dial-Up Networking
This section describes the steps to create and configure a dial-up connection in Windows 95/
Windows NT Dial-Up Networking in this appendix for Windows NT instructions.

Create a Dial-Up Connection 
The connection stores the settings needed to connect to the runtime system. 

To create a dial-up connection in Windows 95/98, complete the following steps:

1. Double-click the My Computer icon on the desktop and then double-click the Dial-Up 
Networking folder.

The Dial-Up Networking window appears.

2. Double-click the Make New Connection icon.
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The Make a New Connection Wizard appears.

3. Enter the name of the computer you are dialing.

Important The name must be “MachineShop Phonebook Entry” if you are using the Direct Con
tion (Serial) option in MachineShop.

4. Select MachineShop Direct Connection as the modem.

5. Click Next.

The following window appears.

6. Enter “1”  as the telephone number and then click Next.
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The following window appears.

7. Click Finish to save the phonebook entry.

Configure the Connection 
Now you need to configure the newly created connection. 

To configure the connection, complete the following steps:

1. Open Dial-Up Networking.

The Dial-Up Networking window appears.

2. Right click on the icon for the newly created connection and then select Properties.
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The property sheet for the selected connection appears.

3. Clear the Use area code and Dialing Properties check box on the General tab 

4. Click Configure to set the baud rate for the MachineShop Direct Connection.

The MachineShop Direct Connection property window appears.
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5. Select the speed that modem will use to transfer data from the maximum speed list.

The default is 115200. This selection must match the baud rate set in the MachineS
Shell. 

Note If you are have reliability problems using the selected speed, try selecting a slower s

6. Click OK  to accept these choices.

The property sheet for the selected connection appears.

7. Click the Server Types tab.

The Server Types tab appears.

8. Clear all check boxes except the TCP/IP check box and then click TCP/IP Settings to 
configure the IP address.
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The TCP/IP Settings window appears.

9. Select Specify an IP address and then enter the IP address for the development syste

CTC recommends that you enter 10.0.0.1 as the IP address for the development sys

Note If you are using both serial and Ethernet point to point connections on the same dev
ment machine, you must have different IP addresses for each connection.

10. Select Specify name server addresses.

Make sure all the addresses are set to 0.0.0.0.

11. Clear the Use IP header compression and Use default gateway on remote network 
check boxes.

12. Click OK  to accept these choices.

The property sheet for the selected connection appears.

13. Click OK  to exit the property sheet.
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Windows NT Dial-Up Networking
This section describes the steps to create and configure a dial-up connection in Windows N

Create a Dial-Up Connection 
The phonebook entry will store the settings needed to connect to the runtime system. The p
book entry is created using Windows Dial-Up Networking.

To create a phonebook entry in Windows NT, complete the following steps:

1. Double-click the My Computer icon on the desktop and then double-click the Dial-Up 
Networking folder.

If there are no previous phonebook entries, the message “The phonebook is empty”
appears. 

Note If a phonebook entry already exists, the Dial-Up Networking window appears. Click New 
to add a new entry and skip to step 3.

2. Click Yes to add an entry. 

The New Phonebook Entry Wizard appears.

3. Enter a name for the new phonebook entry and then click Next.

Important The name must be “MachineShop Phonebook Entry” if you are using the Direct Con
tion (Serial) option in MachineShop.
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The Server window appears.

4. Select Send my plain text password if that’s the only way to connect and then click 
Next.

The Phone Number window appears.

5. Enter “1”  as the phone number and then click Next.

The New Phonebook Entry Wizard appears.

6. Click Finish to save the phonebook entry.

The Dial-Up Networking window appears with the new phonebook entry displayed in
Phonebook entry to dial box.
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Configure the Connection
Now you need to configure the phonebook entry.

To configure the phonebook entry, complete the following steps:

1. Open Dial-Up Networking.

The Dial-Up Networking window appears.

2. Select the phonebook entry from the Phonebook entry list. 

3. Click More and then select Edit entry and modem properties.

The Edit Phonebook Entry property sheet appears.
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4. Click Configure on the Basic tab to set the baud rate for the MachineShop Direct Con
tion.

The Modem Configuration dialog box appears.

5. Select the speed that modem will use to transfer data from the initial speed list.

The default is 115200. This selection must match the baud rate set in the MachineS
Shell. 

Note If you have reliability problems using the selected speed, try selecting a slower spee

6. Click OK .

The Edit Phonebook Entry property sheet appears

7. Click the Server tab.

The Server tab appear.
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8. Clear all check boxes except the TCP/IP check box and then click TCP/IP settings to 
configure the IP address.

The TCP/IP Settings window appears.

9. Select Specify an IP address and then enter the IP address for the development syste

CTC recommends that you enter 10.0.0.1 as the IP address for the development sys

Note If you are using both serial and Ethernet point to point connections on the same dev
ment machine, you must have different IP addresses for each connection.

10. Select Specify name server addresses.

Make sure all the addresses are set to 0.0.0.0.

11. Clear the Use IP header compression and Use default gateway on remote network 
check boxes.

12. Click OK to accept these choices.

The Edit Phonebook Entry property sheet appears.

13. Click OK  to exit the Edit Phonebook Entry property sheet.
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Cable Pinouts

This appendix describes the cable pinouts for a LAN cable, crossover cable, serial cable with
shaking, and a serial null modem cable with loopback. If you should decide to construct you
cable, refer the appropriate diagram below for assistance.

10BaseT, 100BaseT LAN Cable Pinout

Orange-white 1 1 Green-white

Orange 2 2 Green

Green-white 3 3 Orange-white

Blue 4 4 Blue

Blue-white 5 5 Blue-white

Green 6 6 Orange

Brown -white 7 7 Brown-white

Brown 8 8 Brown
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10BaseT, 100BaseT Peer to Peer Crossover Cable Pinout

Orange-white 1 1 Green-white

Orange 2 2 Green

Green-white 3 3 Orange-white

Blue 4 4 Blue

Blue-white 5 5 Blue-white

Green 6 6 Orange

Brown -white 7 7 Brown-white

Brown 8 8 Brown
102 MachineShop Getting Started Guide



Appendix B: Cable Pinouts
Serial Cable with Hardware Handshaking Pinout

9-pin 25-pin 25-pin 9-pin Description

pin 5 pin 7 <---------------> pin 7 pin 5 Ground<---->Ground

pin 3 pin 2 <---------------> pin 3 pin 2 Xmit<---->Rcv

pin 7 pin 4 <---------------> pin 5 pin 8 RTS<---->CTS

pin 6, 1 pin 6, 8 <---------------> pin 20 pin 4 DSR, CD<---->DTR

pin 2 pin 3 <---------------> pin 2 pin 3 Xmit<---->Rcv

pin 8 pin 5 <---------------> pin 4 pin 7 CTS<---->RTS

pin 4 pin 20 <---------------> pin 6, 8 pin 1, 6 DTR<---->DSR, CD
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Appendix B: Cable Pinouts
Serial Null Modem Cable with Loopback Pinout

9-pin 25-pin 25-pin 9-pin Description

pin 5 pin 7 <---------------> pin 7 pin 5 Ground<---->Ground

pin 3 pin 2 <---------------> pin 3 pin 2 Xmit<---->Rcv

pin 7 pin 4 pin 5 pin 8 RTS<---->CTS

pin 6, 1 pin 6, 8 pin 20 pin 4 DSR, CD<---->DTR

pin 2 pin 3 <---------------> pin 2 pin 3 Xmit<---->Rcv

pin 8 pin 5 pin 4 pin 7 CTS<---->RTS

pin 4 pin 20 pin 6, 8 pin 1, 6 DTR<---->DSR, CD
104 MachineShop Getting Started Guide



Machin

Index
A
add

connection
disk transfer 60
Ethernet point to point 43
IPM compatible 58
LAN 40
modem 55
serial 52

suite component 86
Always on Top 84
AutoHide 84

B
backup 64

local 64
remote 66
restore 67

baud rate 92, 98
modify 91, 97

C
cable pinouts 101
configure

dial-up connection
Windows 95/98 91
Windows NT 97

TCP/IP properties
Windows 95/98 43
Windows NT 46

connection
disk transfer 60
Ethernet point to point 43
IPM compatible 58
LAN 40
modem 55
serial 52

create
backup

local project backup 64
remote project backup 66

dial-up connection
Windows 95/98 89
Windows NT 95

project 28
Crossover Cable Pinout 102
Customer Support Services 7
customizing MachineShop 83

add suite component 86
remove suite component 87
visibility 84

D
delete a project 34
development system requirements 11
Dial-Up Networking 55, 56, 89

add connection
Windows 95/98 89
Windows NT 95

configure connection
Windows 95/98 91
Windows NT 97

modify
baud rate 91, 97
TCP/IP settings 91, 97

disk transfer connection 60
docking the toolbar 85
documentation 3

electronic 4
print 3
standards 6

download project 74
download command 76
transfer wizard 74

E
edit I/O interface 37
Edit menu 20
eShop Getting Started Guide 105



Index

 

edit project description 36
Ethernet point to point connection 43

F
File menu 20

H
hardware requirements

development system 11
runtime system 12

Help menu 21
Host Name 42

I
IP Address 42, 45, 48, 50, 57
IPM 17
IPM Compatible Serial connection 58

L
LAN Cable Pinout 101
LAN connection 40
launch

Interact 22, 33
MachineLogic 22, 33

M
MachineLogic source file 76, 77
MachineLogic templates 28
MachineShop

add suite component 86
features 10
remove suite component 87
start 18
visibility 84

MachineShop Direct Connection modem 
90

MachineShop Net 21, 40
MachineShop Net connection

Ethernet point to point 43

LAN 40
modem 55
serial 52

MachineShop Net Name 42
MachineShop Phonebook Entry 52, 53,

90
create 89

Menus 20
Edit menu 20
File menu 20
Help menu 21
Tools menu 21
Transfer menu 21
View menu 20
Window menu 21

modem connection 55

O
Online Help 18
open a project 32
Options command 84

P
Product Technical Support 7
project

backup 64
create 28
delete 34
description 36
directory structure 26
download 74
I/O interface 37
information 35
open 32
overview 26
project path 27
restore 67
save 33
upload 78
106 MachineShop Getting Started Guide



Index

Machin
Project Management Rebar 22

R
rebars 22

move 85
project management 22
suite navigation 22
transfer 23

remove suite component 87
restore 67

local project 67
remote project 70

runtime system requirements 12

S
save a project 33
security key 13
Security Key Utility 14

enable software options 15
transfer options between keys 16

Serial Cable with Hardware Handshaking 
Pinout 103

serial connection 52
Serial Null Modem Cable with Loopback 

Pinout 104
setting project path 27
software requirements

development system 11
runtime system 13

starting MachineShop 18
startup files 27, 35
Suite Navigation Rebar 22

T
TCP/IP properties

configure in Windows 95/98 43
configure in Windows NT 46

TCP/IP settings 93, 99
modify 91, 97

Toolbar
always on top 84
dock 85
hide 84
move 85
moving 20
undock 85
visibility 84

Toolbars 22
Tools menu 21
Transfer menu 21
Transfer Rebar 23

U
undocking the toolbar 85
upload project 78

transfer wizard 78
upload command 80

user interface 20
user-defined toolbar buttons

add 86
remove 87

V
View menu 20
view project information 35

W
Welcome dialog 19
What’s This Help 18
Window menu 21
eShop Getting Started Guide 107



Index
108 MachineShop Getting Started Guide


	Manual Overview and Support Services
	Using this Manual
	MachineShop Documentation
	Print Documentation
	Electronic Documentation

	Related Documentation
	Documentation Standards
	ISO Symbols

	Customer Support Services
	Product Technical Support
	Technical Support Products
	Product Support Program

	Chapter Summary

	Introducing MachineShop
	MachineShop Basics
	Development System Requirements
	Hardware Requirements
	Software Requirements
	Installing the Software

	Runtime System Requirements
	Hardware Requirements
	Installing the Hardware
	Software Requirements
	Installing the Software

	Working with Security Keys
	Understanding the Security Keys
	Using the Security Key Utility
	Enabling Software Options
	Transferring Enabled Options between Keys

	Getting Started with MachineShop
	Users of Interact Project Manager (IPM)
	Online Help
	Starting MachineShop

	MachineShop User Interface
	Menus
	File Menu
	Edit Menu
	View Menu
	Tools Menu
	Transfer Menu
	Window Menu
	Help Menu

	Toolbars
	Project Management Rebar
	Suite Navigation Rebar
	Transfer Rebar


	Chapter Summary

	Managing Projects
	Overview of MachineShop Projects
	Project Directory Structure
	Startup Files

	Setting the Project Path

	Create a New Project
	Open an Existing Project
	Save a Project
	Delete a Project
	View Project Information
	Edit a Project
	Project Description
	I/O Interface

	Chapter Summary

	Adding Connections
	MachineShop Net Connections
	LAN Connection
	Ethernet Point to Point Connection
	Configure TCP/IP Properties in Windows 95/98
	Configure TCP/IP Properties in Windows NT
	Add Connection in MachineShop

	Serial Connection
	Modem Connection

	IPM Compatible Connection
	Disk Transfer Connection
	Chapter Summary

	Backing Up Projects
	Creating a Backup
	Local Project Backup
	Remote Project Backup

	Restoring a Backup
	Restore Backup to the Local System
	Restore Project to a Remote System

	Chapter Summary

	Transferring Projects
	Downloading a Project
	Transfer Wizard
	Download Command

	Uploading a Project
	Transfer Wizard
	Upload Command

	Chapter Summary

	Customizing MachineShop
	Set the Visibility
	Move the MachineShop Toolbars
	Move the MachineShop Rebars

	Add and Remove Suite Component
	Add a Program
	Remove a Program

	Chapter Summary

	MachineShop Dial-Up Networking Connections
	95/98 Dial-Up Networking
	Create a Dial-Up Connection
	Configure the Connection

	Windows NT Dial-Up Networking
	Create a Dial-Up Connection
	Configure the Connection


	Cable Pinouts
	10BaseT, 100BaseT LAN Cable Pinout
	10BaseT, 100BaseT Peer to Peer Crossover Cable Pinout
	Serial Cable with Hardware Handshaking Pinout
	Serial Null Modem Cable with Loopback Pinout

	Index

